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What is World Tools?

Prior to InDesign CS4, the only way to work with documents which con-
tain right-to-left components (which are necessary for Arabic or Hebrew
composition) was by using the ME (Middle Eastern) version of InDesign.
With CS4, this has all changed. Adobe has included an additional composer
called the World-Ready Composer which is capable of composing right-to-
left languages. The World-Ready Composer also has the added capability of
composing Indic languages.

Under the hood, all of the functionality of the ME version of InDesign is
there in every version of InDesign CS4. Adobe has decided to keep this
functionality hidden. The ME capabilities are only apparent when one tries
to open ME documents (they open flawlessly in CS4). The composer which
is enabled by default is the regular composer used in previous versions of
InDesign which does not support right-to-left text.

World Tools was created to exposed this dormant capability within CS4. It
enables the World-Ready Composer and provides a user interface to be able
to use it. It was created to enable all users of InDesign to edit documents
with Arabic, Hebrew, and Indic text.

What World Tools is NOT!

World Tools is not a full replacement for the ME version of InDesign. There
are many reasons why one would want or need to purchase the ME version
of InDesign.

First of all, World Tools is based on technology which Adobe considers un-
supported. Adobe did not expose the World-Ready Composer because they
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are not ready/willing to support it yet. We have tested the technology to
the best of our ability, and it works well, but there are bugs in the composer
which the ME version addresses. If any of these bugs are show-stoppers,
then the ME version is the only solution. We will address bugs in the user in-
terface to the best of our ability, but any bugs in the underlying technology,
are beyond out abilities to address. There is no guarantee by Adobe that they
will even attempt to fix ME related bugs in incremental updates of CS4. This
being said, we would like to receive any information on ME related bugs, so

we can try to analyze them and alert Adobe of their existence.

Also, World Tools does not attempt to achieve the level of integration that
the ME interface has. As a result, the interface of the ME version is much

smoother and more familiar.

If you need control of right-to-left text in Photoshop, Illustrator, or Dream-
weaver, it might pay to buy the ME version of the Creative Suite

Some advantages of World Tools are: 1) price — you don’t need to buy awhole
new program just for right-to-left composition. 2) Timely updates — histori-
cally, the ME updates took much longer to be released than the regular ones.
3) Use of right-to-left functions in the CJK versions of InDesign. The ME
versions and CJK versions of InDesign are mutually exclusive. 4) Localized
interfaces — World Tools can be used with any version of InDesign — no mat-
ter what the language of the user interface might be. The ME version only
has English (IE), French, Hebrew, and Arabic interfaces.

World Tools also includes the functions of Multi-Lingual Tools. Multi-Lingual
Tools is included free with every copy of InDesign ME purchased on the In-

Tools website.
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Currently Multi-Lingual Tools includes the following functions:

1. Apply Hebrew Character Style: This will apply a user-defined character
style for Hebrew text within a non-Hebrew paragraph.

2. Apply Latin Character Style: This will apply a user-defined character
style for text which uses the “Latin” writing script within a non-Latin para-

graph. (“Latin” includes: English, Spanish, French, etc.)

3. Straighten Quotes: This is for making quotes “dumb”. Useful for lan-
guages which don’t use curly quotes, such as Hebrew.

4. Switch Story Direction: This provides a menu item for reversing story
direction. The menu item makes it possible to assign a keyboard shortcut to
reverse the direction from right to left and left to right.

S. Create Spread Numbering: This creates “spread numbering” in which
both pages on a spread will be assigned the same number. The numbers will

only increase every other page.
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Installation

About APID ToolAssistant

APID ToolAssistant, version 1.0.45
by Kris Coppieters - Rorohiko Ltd.
(c) 2005-2008 Rorohiko Ltd.

http:/ /www.rorohiko.com

APID ToolAssistant - licensing status. Click-select a line to enable buttons

(@SavedPrefs - 4
Autoflow Demo (22 days remaining) 1.0b4 b
DropWords Demo (22 days remaining) 1.0b1 I
FormattingTools Demo (22 days remaining) 1.0b2
InToolsCore - 1.01
LayoutTools Demo (22 days remaining) 1.0b4 ]
MultiLingualTools Demo (22 days remaining) 1.0b2 2 )
Import License File... Get License...

T

World Tools is different from most plug-ins. It was developed using a product
called “APID ToolAssistant” created by Rorohiko. This provides a central
controller that performs much of the low-level processing. If your are inter-
ested in the technology behind the development of this product, you can read the
addendum in the back of the manual.

There are five different files which must be installed for World Tools to func-
tion properly: 1. APIDToolAssistantCSx.xxx (the exact name depends on
your version) 2. @SavedPrefs.spln 3. WorldTools.spln 4. LtRTem-
plate.idml §.RtLTemplate.idml.

All of these files need to be copied to InDesign’s plug-ins folder, and files
#3,#4, and #S, must be in the same sub-folder! We recommend copying the
World Tools Folder in its entirety to your plug-ins folder. This insures that
the correct files stay together.
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Please note: APID ToolAssistant replaces an older version of the plug-in. In
the past, there were two versions of the API plug-in distributed by Roro-
hiko. Active Page Items Developer (APID), was the version developed to
work with externally developed plug-ins. The free Active Page Items Run-
time (APIR), was for plug-ins developed internally at Rorohiko. If you have
either of these two plug-ins installed, you must remove them and install
the APID ToolAssistant instead. The older APIR or APID plug-ins will not
work. You must have the most current version of the APID ToolAssistant
installed (version 1.0.46).

Shown on the previous page is the “About” window of APIL This window
can be brought up in two ways: 1. Select InDesign > About Plug-Ins >
Rorohiko Ltd. > APID ToolAssistant... 2. API > APID ToolAssistant...

In-Tools plug-ins do not show up separately in the “About Plug-Ins” menu.
Information on installed In-Tools plug-ins is only displayed in the “About”
window of APL If the plug-ins are properly installed you should see the dis-

played window (or the equivalent Windows version).

Please note the API version number near the top of the window. Your ver-
sion number must say 1.0.46 or higher. Additionally it must say “APID
ToolAssistant”. If it says “Active Page Item Developer” or “Active Page Item
Runtime”, you have the wrong version installed. As mentioned above, both

of these versions have been replaced with APID ToolAssistant.

When in doubt: search your plug-in folder for a file whose name contains

“ActivePageltem”, and replace it with the new one.

In the “About” window, there is a list of all installed plug-ins and their status.
The first column lists the plug-ins. The second column shows the license sta-
tus. If the plug-in is licensed, “Licensed For APID” will be displayed. If the
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plug-in is in demo mode, the word “Demo” will be displayed along with the
number of days remaining until the plug-in expires. The third column shows
the plug-in’s version number. When trying to determine that you have the
most current version of a plug-in, please refer to the version number listed

in this column.

Enabling and Disabling Plug-ins
To enable or disable any individual plug-in, simply move the file into or out of
your plug-ins folder. One simple solution would be to create two folders, one
within your plug-in folder named “API”, and the other in the InDesign appli-
cation folder (but outside the plug-ins folder) named “API disabled”. You can
then easily move files back and forth.

After installing In-Tools plug-ins, InDesign should be restarted to avoid pos-

sible conflicts.

Please note: In-Tools plug-ins are unique, in that menu items will not appear
until a document is opened. The plug-ins will appear in the plug-in list in the
“About” window, but menu items only appear after a document is opened

or created.

Purchasing Licenses and Activation

There are two ways to purchase In-Tools plug-ins: They can be purchased
from the In-Tools web site prior to activation, or they can be purchased di-
rectly from within InDesign. If the plug-ins are purchased from the web site
without being referred by InDesign, you will establish a login and password
for activation at the time of purchase. If you purchase the plug-ins from
within InDesign, the payment and activation both occur simultaneously. If

you plan to purchase a plug-in package, or would like to purchase a number
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of plug-ins in one transaction, you should purchase them from the In-Tools

web site before you initiate the activation process.

No matter how you purchase the plug-ins, the process from within InDesign

is the same:
1. Select the plug-in you would like to activate.

2. Click “Get License”. This will take you to the log-in page of the In-Tools
web site.

Customer Login

Please login using your email address and password to continue.

Email Address:

Password:

(Login)

If you do not yet have an In-Tools account, create one below.

Please enter your email address and choose a password. You will use this password to legin to your account in
order to install a license from within Indesign.

Name/Company:

Email Address:

Choose a Password:

Confirm Password:

Submit

If you already have an In-Tools account, fill in your login and password. Oth-
erwise create an account now. If you already paid for your plug-ins, make
sure you fill in the login information you provided at the time of purchase.
You must provide a valid e-mail address or you might not receive your li-

cense file.

3. Ifyou have not yet paid for the plug-in you will be taken to a PayPal pay-
ment page. On successful completion of the payment, you will be returned
to the log-in page.
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4. After successfully completing the log-in procedure, you will receive a
link to download a license file. Once you have purchased a license to an In-
Tools plug-in, you can download the license file at any time, by logging into
your In-Tools account and clicking on “Show License” next to any activated
license. The license file is specific to the installation from within which you
have activated the license. It will not work on a different installation, even
with the same serial number. We recommend naming your installations on
you account page so you will be able to identify each installation you might
have in the future. If you need to use In-Tools plug-ins with more than
one installation of InDesign, you will need to purchase an additional li-
cense for each installation. Therefore, even if you have a personal copy
of InDesign on both your desktop and laptop with the same serial num-

ber, you will need to purchase two licenses.

5. Once you have your license file, go back to the “About” window in InDe-
sign, select the plug-in you are activating and click on “Import License File”.
Locate the file on your hard drive and click “Open”. The status next to your

plug-in will change to “Licensed”.

Please note: Under certain circumstances while trying out our plug-ins, you
might see the APID ToolAssistant listed as unlicensed. There is no need to
purchase a license for the APID ToolAssistant if you plan on purchasing
any In-Tools plug-ins. The licensing of APID ToolAssistant is handled com-
pletely transparently when you purchase an In-Tools plug-in. An In-Tools
license will automatically license APID ToolAssistant as well. The end re-
sult will be a licensed copy of APID ToolAssistant, but you will not see (or

need) any license file for it.
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Introduction

Directional Settings
There are many different levels of directional controls when dealing with

right-to-left text. Below is an overview of what each type of control does.

1. Document Direction: Controls the binding direction (i.e. which way
the book opens). When a book lays with the front cover up, a left bound
(Roman) document has the spine on the left side, while a right-bound doc-
ument has the spine on the right. Document direction can only be set by

World Tools when creating the document.

2. Story Direction: Controls which way the columns flow in a multicolumn
text frame. The story direction is controlled in the ME version by using the
ME text frame tool when creating the story, or changing the story direction
in the story panel. In World Tools, it’s controlled by using the Switch Story

Direction menu option, I's a toggle control which switches back and forth.

3. Table Direction: Controls the column direction within tables. In the
ME version, it’s controlled by a button on the tables panel, in World Tools,

it’s controlled by the Table direction menu options.

Please note: There is no option for setting the table direction in table styles.

Table direction must be set manually for each table.

4. Paragraph Direction: Do not confuse this with paragraph alignment.
The paragraph direction controls the overall direction of a paragraph. For
example: if you type an English word and then a Hebrew/Arabic word fol-
lowed by a period, if the paragraph direction is left to right the English word
will be on the left, the Hebrew/Arabic word will be to the right of that, while
the period will be all the way on the right. If the paragraph direction is right
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to left, the direction will be reversed with the English word on the right, the
Hebrew/Arabic word to the left of that, with the period all the way on the
left. If there is not a mix of directions within the paragraph (i.e. all English
text), the only effect of paragraph direction will be on the punctuation at the
end and the position of drop caps/numbering/bullets.

unm  There is a difference in behavior between the ME version and
World Tools. In the ME version, when you change the paragraph
direction, the paragraph alignment is automatically reversed
as well. We have found this behavior annoying (we think the
alignment should be kept as it’s defined!) so we changed it in
World Tools The alignment can be manually set to whatever you

want.

S. Character Direction: This controls the direction of characters. “Word”
will come out “droW” when set to right to left. “Default” determines the di-
rection based on the writing script. When set to “Default” neutral characters

(like punctuation) are determined by the surrounding characters.

6. Keyboard Direction: In CS2 version 4.0.2, Winsoft introduced “Key-
board Direction”. The idea sound nice at first, but one which we believe is ill
conceived. Basically Keyboard direction does the same thing as Character
Direction (although character direction trumps keyboard direction when
there’s a conflict). The difference is that keyboard direction can be set au-
tomatically while typing. There’s an option to have the keyboard direction
on neutral characters inferred by the keyboard layout used when typing. If
a right to left keyboard layout is used, the keyboard direction is set to right
to left and vice versa. The problem is (besides the double functionality) that
people don’t always use the correct keyboard layout while typing. When
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switching between languages, it’s very common to not switch keyboard lay-
out until starting to type. The neutral characters then have their direction
set by the user. The real problem is directional neutral characters (like pa-
renthesis, brackets, etc.) The appearance of the characters are affected by
their direction. For example: (parenthetical statement) will be encoded
<0028>parenthetical statement<0029> if the parenthesis are right to left
and <0029>parenthetical statement<0028> if the parenthesis are left to
right. This really gets messy once you start doing search and replaces, etc.

Things get really messed up and the user has no idea why...

To make matters worse, the keyboard direction settings do not show up as
style overrides so there’s no indication that they are applied unless you go

and check the keyboard direction menu listing...

We have not included the ability to set keyboard direction because we are
opposed to its existence. We strongly advise anyone receiving files from an
outside source to use the “Remove Keyboard Direction Overrides” com-
mand to ensure there are no keyboard direction settings anywhere in the

document.

World-Ready Composer

As stated above, InDesign’s World-Ready Composer creates the ability to
properly compose right-to-left text and all related features. It is our under-
standing that the World-Ready Composer is based on Winsoft’s ME code
base, so for the most part, the functionality should be similar to the ME
version. Any features relating to text composition which are available in the
ME version, but have not been available in the Roman version, will only
be properly composed if the World-Ready Composer is enabled. Any bugs
which might be related to the World-Ready Composer will also only be an
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issue if the World-Ready Composer is enabled for specific text. Some exam-
ples of features which are only available with the World-Ready Composer

are: localized digits, diacritic positioning, Hebrew / Arabic numbering, etc.

Please note: The World-Ready Composer and the Japanese Composer of the
CJK (Chinese, Japanese, and Korean) versions of InDesign are mutually ex-
clusive. The World-Ready Composer does not support CJK line breaks or
the other CJK features, and the Japanese Composer does not support right-
to-left text or other ME features. This means that you must choose whether
you need proper ME / Indic composition, or CJK composition. Each para-
graph can be set with a different composer. For paragraphs with mixed CJK
and ME / Indic text, you must decide which composition rules are more
important. The Japanese Composer is only available in the CJK versions of

InDesign.

Working with World-Ready Documents

There will be three instances where you would be working with a World-
Ready document. 1) You are working on an existing ME document (created
in the ME version). 2) You are creating a new document which will have
right-to-left text. 3) You are editing an existing Roman or CJK Document,
and would like to add right-to-left text to the existing document.

Existing ME Documents

Existing ME documents will open correctly in any version of InDesign. You
do not even need World Tools for this. The World-Ready Composer will be
enabled by default and you can even make minor edits to the ME text. For
any edits which require control over ME features, though, you would need
either World Tools or the ME version of InDesign.
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New Documents

By default, new documents in InDesign do not have the World-Ready Com-
poser enabled. To enable the World-Ready Composer, you can simply cre-
ate a new document and select the World-Ready Composer instead of the
regular composer. There is also “Enable World-Ready Composition” in the
menu options which enables the World-Ready Composer for all text and
paragraph styles in the document.

The best way to create a World-Ready Document though, is by selecting File
> New > World Ready Document. Keep in mind these commands will
not show unless you have previously opened a document in your current
InDesign session. If your document is to be right bound select File > New
- Right Bound Document. The difference between creating a fresh World
Ready Document and selecting “Enable World-Ready Composition” is in
the root style. The root style (what is referred to as “No Paragraph Style”) of
an existing document cannot be changed. An new World Ready document

will have the root style set to the World-Ready Composer as well.

Please note: Binding direction can only be set by creating a new right bound
document. If you need to change the direction of an existing document, we
recommend creating a new document with the correct binding direction,
setting the page size to the size equal to the original document and copying

all the pages using the pages panel.

Existing Documents

To add ME or Indic text to an existing Roman or CJK document, you must
enable the World-Ready Composer. For Roman Documents, you can sim-
ply select “Enable World Ready Composition”. This will change any instance

of the regular Paragraph Composer or Single-line Composer to the corre-
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sponding World-Ready Composer. For CJK documents, selecting this op-
tion will not have an effect on text that has the Japanese composer applied.
Instead you must select the World-Ready Composer for the appropriate
paragraphs or Paragraph Styles.

Character Settings

Openlype Settings

There are a number of OpenType settings not normally available in the Ro-
man version of InDesign. World Tools makes these settings available under
the Character menu. The OpenType features require a font which supports
them. The additional features available are as follows: 1) Historical Forms:
These are special forms of letters which are generally somewhat archaic.
2) Justification Alternates: These are special stretched forms of glyphs which
are generally used to better justify text. These are the forms used by “Naskh
Justification”. 3) Localized Forms: There are different forms of glyphs in
some languages. This feature applies the localized form. 4) Mark Position-
ing: Presumably this applies mark positioning programmed using the “mark”
OpenType feature. In our tests, we have not seen any effect by changing this
setting. We recommend using the Diacritic Positioning settings instead.
S) Overlap Swash: This enables swashes to overlap the following glyph pre-
venting unsightly spacing. This is commonly used in Arabic. 6) Stretched
Alternate: Enables the stretched forms of glyphs. 7) Stylistic Alternate: Uses
the glyph form programmed with the “salt” OpenType feature.

Kashidas
This option enables the use of kashidas in Arabic fonts. Kashidas are ex-
tended elements of glyphs which are used when justifying Arabic text.
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Digit Types

Different languages around the world use different digit formats. The most
commonly used format for digits is what we call Arabic digits (1,2,3, etc.).
The World-Ready Composer supports 18 different digit formats.

Diacritic Positioning

(&] Diacritic Positioning...

Diacritic Position " OpenType I-G-i

Horizontal 0 Vertical 0

The Diacritic Positioning dialog is a non-modal dialog which controls the
position of diacritic marks. For automatic OpenType positioning of marks,
select “OpenType” from the upper drop-down list. If you are using an old-
er non-OpenType font, you can select any one of the other options. The
“Loose”, “Medium” and “Tight” settings affect the vertical placement of dia-
critics in Arabic. In addition to the automatic placement, the diacritic can be
manually moved by editing the Horizontal and Vertical values. These values

are measured in 1/1000 em units.

Character Direction

Character direction controls which characters are considered right-to-left
and which ones are considered left-to-right. Under normal circumstances
Roman characters (as well as most writing scripts in the world) are left-to-
right. Arabicand Hebrew are the primary examples of scripts which are right-
to-left. When the character direction is set to “Default” InDesign tries to de-
termine automatically what the correct character direction is. For the most
part, this is simply a function of which Unicode range the glyph falls within.
If it’s in the Hebrew or Arabic range, it will be right-to-left, otherwise, it will
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be left-to-right. For neutral characters (i.e. punctuation), InDesign uses an
algorithm to determine if they should be right-to-left or left-to-right. This is
based on the paragraph direction as well as the surrounding characters. Gen-
erally the Character Direction should be left with the default setting, unless
the default behavior puts neutral characters in the wrong place.

Keyboard Direction

In World Tools we did not include the ability to set keyboard direction. We
do not recommend its use, and we recommend removing all keyboard di-
rection overrides on existing documents by selecting API >World Tools

> Character Direction >Remove Keyboard Direction Overrides.

Paragraph Settings

Paragraph Direction

The paragraph direction sets the overall direction of the paragraph. A com-
mon mistake is to associate paragraph direction with paragraph alignment.
A right-to-left paragraph can be left aligned or left justified and a left-to-right
paragraph can be right aligned. The paragraph direction controls the place-
ment of blocks of text. For example: if you type an English word and then a
Hebrew/Arabic word followed by a period, if the paragraph direction is left
to right the English word will be on the left, the Hebrew/Arabic word will
be to the right of that, while the period will be all the way on the right. If the
paragraph direction is right to left, the direction will be reversed with the
English word on the right, the Hebrew/Arabic word to the left of that, with
the period all the way on the left. If there is not a mix of directions within the
paragraph (i.e. all English text), the only effect of paragraph direction will be
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on the punctuation at the end and the position of drop caps/numbering/
bullets.

Here are some examples of left aligned left-to-right paragraphs:

. Abulleted paragraph.

“nay” is “Hebrew”.

“duy=l)” is “Arabic”.

Here’s a few left aligned right-to-left paragraphs:

.A bulleted paragraph .
“Hebrew” m “m»1y”

“Arabic” 5eSs “duyell”

Paragraph Numbering Formats
Besides the standard Roman Numbering Formats for numbered lists, World

Tools includes six ME numbering formats as well as eleven CJK formats.

Paragraph Justification Options

There are three different paragraph justification options available. These are
all applicable when the text is set to “justified”. The “Standard” setting simply
adds space to justify text. The “Arabic” option will use kashidas to take up
space if kashidas are enabled. The “Naskh” option will use naskh justifica-
tion. Ifan OpenType font has justification alternates (jalt) programmed into
the font and “Naskh” is selected, these alternates will be used to justify the
text. The algorithm used is unpredictable. The justification alternates will
work in any language, but it requires the font to be programmed with justi-

fication alternate glyph. There are a number of Hebrew fonts programmed
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with stretched justification alternate glyphs which will be used automati-
cally when “Naskh” is selected. The same would be true with Roman fonts
programmed with justification alternates, but we do not know of any fonts

which currently have such capabilities.

Style Settings

a8 ‘World-Ready Style Options
— Paragraph Styles ——————— — Paragraph Settings
Lo ' g Paragraph Direction: | Left to Right H-]
Normal I:
v . f -
Preformatted Text ;p Numbering Style H
> Header Styles Justification " Standard '-H
A excuSiyies Composer | Adobe World-Ready... H-]
Main Text
Number Level 2
Numbered List — Character Settings
: — =
Caption Character Direction: ' Default H
Screen shot trailer Digits | Default '-H
Picture Anchor ™ Kashidas [ Historical Forms ] Justification Alternate
Tip Style ™ Localized Forms M Mark Positioning | Overlap Swash
License Agreement " Stretched Alternate || Stylistic Alternate
P Hebrew Styles ¢ Diacritic Position | OpenType |-H
P Arabic Styles )] — ——
b TOC Styles 23 Horizontal 0 Vertical 0
i C—— ) <>
( Close ) ( Reset )

World Tools has a unique dialog for applying World-Ready options to your
existing Paragraph and Character styles. Shown above is the paragraph style
dialog. The character style dialog is similar, but without the paragraph lev-
el attributes. The list on the left shows the styles in your document, with
World-Ready attributes on the right.

To set style attributes, select a style on the left and select the appropriate
attribute on the right. Any selections will be applied immediately. In addi-
tion, style groups can be selected. When a style group is selected, the attri-
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butes will reflect all the styles and sub-styles in the group. If there are con-
flicting settings, the drop-downs will be blank and the check-marks will not
be checked. When selecting an attribute for a style group, the attribute will
be immediately applied to the entire group including styles within any sub-
group. This is a quick way to apply attributes to many styles at once. If you
wish to undo settings applied, you can press the “Reset” button underneath
the listing of the style tree. The “Reset” button will reset all attributes listed
back to the settings of the based-on style. For character styles that are not
based on another style, it will reset the attributes to be not applied.

Find/Change Options

I
Find what: [ Done 1 | | [—
I + World Options...
Change to: Tab

/@  Forced Line Break

I-H End of Paragraph

Search: | Document
"k =hE r= Symbols

Markers

i 2 Hyphens and Dashes

4 White Space

Quotation Marks
Break Character
Je Variable

Other

el

Change Format

¥y ¥YYYY ¥YYYY

W Wildcards

World Tools enables the use of additional World-Ready options in the Find/
Change dialogs. To set these additional options you must call up a special
dialog for selecting these options. There are four different such dialogs
which can be called up: 1) Find Text Options, 2) Change Text Options, 3)
Find Grep Options, and 4) Change Grep Options. The dialogs are identical
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and they are each called up from the metadata drop-down next to the cor-
responding input field. Shown above is the Find Text metadata drop-down

menu with the “World Options” menu option selected.

World Tools Find Options

— Paragraph Settings
Paragraph Direction: ' Right to Left H.l
Numbering Style )
Justification | )
Composer |-6-]
— Character Settings
Character Direction: =)
Digits | Default |-6-]
[IKashidas [ Historical Forms | Justification Alternate
I Localized Forms [ Mark Positioning || Overlap Swash
) Stretched Alternate [ Stylistic Alternate
Diacritic Position )
Horizontal Vertical

Above is a screen shot of the Find Text dialog. As you can see, the options
are the same as the style setting dialogs. On the top are the World-Ready
paragraph options, while the bottom contains the World-Ready character
options. After selecting the appropriate options, click “OK” and the selected
options will be applied to the Find/Change attributes. If you would like to
reset the World-Ready options to “no” value, simply select “Reset Options”.
This will remove all World-Ready attributes from the currently selected
Find/Change options.

Find Format:

+ Paragraph Direction: Right To Left ;‘T

k|

As shown above, any World-Ready options selected for Find/Change, will
appear in the format list. Clicking the “Trash Can” will clear all options in-
cluding World-Ready ones.
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Other Options

Table Direction

The direction of a table determines whether columns start on the left or
right. The table direction is set by selecting API > World Tools > Table
Direction > (Left To Right / Right To Left). Table direction cannot be set

in table styles. The direction must be set manually on an individual basis.

Story Direction

The story direction controls whether columns of text in multi-column
frames flow from the right-to-left or left-to-right. The story direction is indi-
cated by the position of the in-ports and out-ports of text frames. The story
direction can be switched at any time by selecting API > World Tools >
Switch Story Direction.

Footnote Numbering Options
Besides the standard Roman footnote numbering formats, World Tools in-
cludes four ME numbering formats as well as two CJK formats. This setting

is a document-wide setting, and is applied to the current document.

Chapter Numbering Formats
The Chapter Numbering format is also a document-wide setting. World

Tools includes six ME formats and eleven CJK formats.

Page Numbering Formats

The page numbering format is the format that the numbers take when using
automatic page numbers. Besides for the standard Roman number formats,
World Tools enables the use of four ME formats. The page numbering format

is applied to the section of the current active page.
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World-Ready Composer

World Tools adds two new menu items to the Control Panel and Paragraph
Panel drop-down menus. Besides the standard Single-line and Paragraph
Composers, you can select the World-Ready variants of these composers.
Usually, there’s no reason you'd want to use the regular composers over the
World-Ready ones. The World-Ready Composer is a super-set of the regular
composer. However if you encounter a bug which is specific to the World-
Ready Composer, switching to the regular composer would be a work-
around the bug (although that would preclude working with ME text.) Also,
if you are using the CJK versions of InDesign, you might want to select the
Japanese Composer instead. The World-Ready Composer is a parallel com-

poser, and does not support the Japanese aspects of the Japanese Composer.

Additional Options

Apply Language Styles

A “writing script” is the set of characters used by the computer to compose
text. Each writing script uses a unique set of characters. Each scriptis unique,
but a script can include more than one language. For example, the Hebrew
script is used by Hebrew and Yiddish. The Latin script is used by English,
Spanish, French, and many others. The “Apply Style” functions recognize

characters based on their script, and apply character styles accordingly.

In the following example, we are showing the “Apply Hebrew Character
Style” option. Other language style options are similar. “Apply Hebrew
Character Style” should be used when the main paragraph text is in a lan-
guage other than Hebrew, and the Hebrew text needs its own formatting.

It identifies any text belonging to the Hebrew writing script, and takes into
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consideration all Hebrew letters, nikud (vowel marks), and taamei hamikra
(cantillation marks). Additionally, it makes all single and double quotes
“dumb”, and applies the style to punctuation within Hebrew text. For ex-
ample the statement: This is javn “Tixn” 190! becomes: This is payn "71xn” 790!
In this example the Hebrew style is styled with Fontbit’s (a Hebrew font
foundry) David font at a reduced size, the quotes within the Hebrew state-
ment had the Hebrew style applied to it and were straightened. The excla-
mation point immediately after the Hebrew text retains its regular format-

ting. The character style should be set before running this command.
Apply Style To Hebrew Characters:

~ M Find By Styles ok )
Source Paragraph Style: [ Any I-i-] (w>

Source Character Style: f Any I-H

Character Style to Apply: [ [None] H-]
Apply To Numbers ||

Apply To: () Document
(") Story
f®) Selection

The above dialog box shows the options for applying the style. In the dialog,
there are three general areas. If the “Find by Styles” check-box is disabled, the
styles will be found based on the current Find Text settings. If the check-box
is enabled, current find settings will be ignored, and the selected paragraph
and character styles selected in the top area will be used instead. In the top

area of the dialog, there are two drop-down dialogs. The top drop-down is
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for selecting which paragraph style should be searched, and the second drop-
down is for selecting which character style will be searched. In the “Source
Paragraph Style” drop down list you can either select “Any” or a specific
Paragraph Style in your document. Choosing “Any” will apply the character
style to any Hebrew text in all the paragraphs of the specified range. Choos-
ing a specific style will limit the application of the style to text styled by that
specific Paragraph Style. The same is true for the character style drop-down.
You can select both a paragraph style and a character style if desired.

The second area of the dialog has two options. Use the “Character Style to
Apply” drop down list to select the Character Style you wish to apply. Select
“Apply to Numbers” if you wish to apply the style to numbers within the text

range as well.

The bottom section in the dialog allows you to select the text range. The op-
tions are context sensitive. If there is nothing selected in the document, the
only selectable range will be the document. If there is a story or part thereof
selected in the document, the “story” radio button will appear. If there are
at least two characters selected, the “Selection” radio button will appear as

well. Selections can be either text or text frames.

Currently, there are two writing scripts available in the “Apply Language
Styles” list: Hebrew and Latin. We will add more language scripts as they

are requested. If there’s a writing script you would like to see, let us know!
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Straighten Quotes
Hebrew and some other languages do not use curly quotes. Very often, curly
quotes can creep into Hebrew text unintentionally. Straighten Quotes was

created to deal with this issue.

Straighten Quotes based on Style

Character Style to Change: = Any | :] (——B—I(—-)
Paragraph Style to Change: = Any ) CGancel—

Apply To: ® Document
() Story
() Selection

The options in the above dialog box are self-explanatory. Select a character
style, a paragraph style, both, or neither. You can also select the text range as

in to the “Apply Character Style” dialogs.

Switch Story Direction

In the ME version of InDesign, story direction is determined by which text
tool used to draw the text frame containing the story. If the special ME type
tool is used, the story direction will be right-to-left. If the regular type tool
is used, the story direction will be left-to-right. The direction of existing sto-
ries are changed in the Story Panel. The importance of story direction is
primarily in the direction of text flow in multi-column text frames. The story
direction is set for the story as a whole, and not on a frame by frame basis.
When combining text frames of two stories, the direction is determined by
the first text frame in the thread.

World Tools does not contain the ME text tool or the ability to change the

story direction in the Story Panel. Instead, all stories start of being left-to-
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right, and the “Switch Story Direction” option provides a convenient way
to change the story direction. Since the command is a menu item, it allows

you to create a keyboard shortcut make changing story direction even easier.

Number by Spread
This utility offers the option to increase page numbering once per spread
instead of once per page. This is useful when both pages in a spread need to

show the same page number.

Spread Numbering

Starting Page: ' 1 ) ook )
Ending Page: | 7 }:} ( Cancel )

By default, the starting page will be the first page in the document, and the
ending page will be the last. These numbers can be set to any page in the

document, thereby giving spread numbering to only part of the document.

Undoing Spread Numbering
Spread numbering can be undone as well. The numbers in the drop-down

list will be the current page numbers — 1,1,2,2, and so on.

Addendum

What is “APID ToolAssistant”?

Classically, there are only two ways to automate InDesign. One way is by
scripting. Scripts are a series of commands written in one of the three sup-
ported scripting languages — AppleScript for the Macintosh, Visual Basic
for Windows, or ExtendScript for both platforms. ExtendScript is Adobe’s
version of Javascript. For scripts to run, they must be placed in the applica-
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tion script folder and explicitly run. For automation to be truly automatic,
it requires “event processing”. This means that certain events trigger specific
processes to take place. There is limited event-triggered scripting available
in CS3 and later.

To achieve true integration, plug-ins must be programmed using c++. De-
veloping c++ plug-ins is a very involved, and lengthy process. APID ToolAs-
sistant is a plug-in which allows very fine grained event processing using Ex-
tendScript. It allows for creation of advanced plug-ins in a fraction of the
time required when programming using c++. It also aids in the creation of

hybrid plug-ins which mix ExtendScript and c++ for maximum efficiency.

Without the APID ToolAssistant, it would not have been possible to cre-
ate the collection of plug-ins we offer in the same amount of development
time. This increased programming efficiency means more functionality for

the end user and lower prices.

Additionally, APID ToolAssistant offers the ability to attach scripts to spe-
cific objects. These attached scripts can be run automatically when triggered
by specific events. Anyone who has a licensed version of the APID ToolAs-
sistant plug-in installed can create and use these attached scripts. There
are also additional scripting properties and methods which are usable by

scripters.

For more information see Rorohiko’s web site at www.rorohiko.com.


www.rorohiko.com
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License Agreement
Please read the following document carefully!

This is a legal agreement (the Agreement) between you and Print Israel LLC (In-
Tools), the developer of the In-Tools software. This Agreement pertains to your use of
the In-Tools software and documentation which are provided to you by In-Tools (col-
lectively, the Software). By copying, installing, or otherwise using the Software, you
accept all the terms and provisions of the Agreement.

Terms of Use
The provisions of the In-Tools Privacy Policy are incorporated herein and made a part

hereof.

License

This Agreement grants you a personal, non-exclusive, non-transferable, non-sublicens-
able right to use one copy of the Software for use on a single computer and/or worksta-
tion for each license that you purchase. You may try the Software before purchasing a
license, for the specified amount of time in the materials accompanying the Software.
YOU UNDERSTAND AND AGREE THAT BY USING THE TRIAL SOFTWARE,
AFTER THE AMOUNT OF TIME YOU MAY NOT BE ABLE TO CONTINUE
TO USE THE SOFTWARE UNLESS YOU PURCHASE A LICENSE.

In-Tools reserves all rights in the Software not expressly granted herein, including
without limitation ownership and proprietary rights.

License Restrictions
You may not reverse engineer, decompile or disassemble the Software. The restrictions

contained herein apply equally to any updates that may be provided to you by In-Tools.

Intellectual Property Rights and Third Party Materials

All service marks, logos, trade names, trade dress, and trademarks of In-Tools (col-
lectively Marks) are the exclusive property of In-Tools and nothing in this Agreement
shall grant you the license to use such Marks. All intellectual property rights in the


http://www.in-tools.com/privacy.html
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Software are owned exclusively by In-Tools and are protected by United States of
America copyright laws and international copyright treaty provisions. Any violation of
the terms set forth herein is expressly prohibited by law and may result in severe civil

and criminal penalties.

Disclaimer of Warranties

ALL SOFTWARE PROVIDED BY IN-TOOLS ARE PROVIDED AS IS. IN-TOOLS
AND ITS AGENTS, PARTNERS, OR EMPLOYEES MAKE NO REPRESENTA-
TION OR WARRANTY TO YOU OR ANY OTHER PERSON OR ENTITY,
WHETHER EXPRESS, IMPLIED, OR STATUTORY, AS TO THE DESCRIP-
TION, QUALITY, TITLE, NON-INFRINGEMENT, MERCHANTABILITY,
COMPLETENESS, OR FITNESS FOR A PARTICULAR USE OR PURPOSE AS
TO THE SOFTWARE PROVIDED TO YOU, ORAS TO ANY OTHER MATTER,
ALL SUCH WARRANTIES HEREBY BEING EXPRESSLY EXCLUDED AND
DISCLAIMED.

NEITHER IN-TOOLS NOR ANY OF ITS AGENTS, PARTNERS, OR EMPLOY-
EES WARRANTS THAT THE SOFTWARE OR SERVICES ARE ERROR FREE
OR WILL OPERATE WITHOUT CAUSING LOSS OR INTERRUPTION YOUR
COMPUTER USAGE OR DATA. YOU ASSUME TOTAL RESPONSIBILITY
AND RISK FOR YOUR USE OF THE SOFTWARE.

Limitation of Liability

IN NO EVENT SHALL IN-TOOLS, ITS AFFILIATES, SUBSIDIARIES, PAR-
ENT COMPANIES, AGENTS, NETWORK SERVICE PROVIDERS, PARTNERS,
OR EMPLOYEES BE LIABLE TO YOU OR ANY THIRD PARTY IN ANY RE-
SPECT FOR ANY COSTS OR DAMAGES ARISING EITHER DIRECTLY OR
INDIRECTLY FROM THE USE OF IN-TOOLS SOFTWARE INCLUDING
WITHOUT LIMITATION ANY ACTUAL, INCIDENTAL, CONSEQUENTIAL,
EXEMPLARY, PUNITIVE, RELIANCE OR SPECIAL DAMAGES, OR FOR ANY
LOSS OF REVENUE, PROFITS, USE, DATA, GOODWILL OR BUSINESS OP-
PORTUNITIES OF ANY KIND ORNATURE WHATSOEVER, ARISING IN ANY
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MANNER FROM ANY CAUSE OF ACTION OR CLAIM RELATING TO THIS
AGREEMENT, TO THE SERVICES PROVIDED BY IN-TOOLS ORTO THE USE
OF THE SOFTWARE. THIS LIMITATION OF LIABILITY APPLIES EQUALLY
TO ANY THIRD PARTIES WITH WHOM IN-TOOLS ENTERS INTO A BIND-
ING AGREEMENT TO MARKET, DISPLAY AND/OR DISTRIBUTE THE
SOFTWARE TO END USERS AND SUCH THIRD PARTIES SHALL NOT BE LI-
ABLE TO YOU ORANY OTHER THIRD PARTY FOR ANY OF THE DAMAGES
SET FORTH ABOVE.

Export Control Laws.

You agree to comply with all laws, rules and regulations applicable to the export of the
Software. Specifically, you shall not export, re-export or transship the Software, or the
direct product thereof, in violation of any United States laws and regulations which
may from time to time be applicable. None of the Software or underlying information
or technology may be downloaded or otherwise exported or re-exported (i) into, or
to a national or resident of, Cuba, Iran, Iraq, Libya, North Korea, Sudan, Syria or any
other country to which the U.S. has embargoed goods; or (ii) to anyone on the U.S.
Treasury Department>s list of Specially Designated Nationals or the U.S. Commerce
Department>s Table of Denial Order. By downloading or using the Software, you are
agreeing to the foregoing and you are representing and warranting that you are not
located in, under the control of, or a national or resident of any such country or on any

such list.

Jurisdiction and Other Provisions

This Agreement and the relationship between In-Tools and you shall be governed in
accordance with the laws of the State of New York. Any dispute between you and In-
Tools regarding this Agreement will be subject to the exclusive jurisdiction of the state
and federal courts in the State of New York. You agree to submit to exclusive jurisdic-
tion in the State of New York, and you expressly waive all defenses to jurisdiction.

This Agreement is the entire agreement between you and In-Tools relating to your use

of the Software and supersedes any other communications or advertising with respect
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to the Software. If any provision of this Agreement is held invalid, the remainder of
this Agreement will continue in full force and effect. In-Tools failure to insist upon or
enforce strict performance of any provision of this Agreement shall not be construed
as a waiver of any provision or right. Neither the course of conduct between the par-
ties nor trade practice shall act to modify any provision of this Agreement. In-Tools
may assign its rights and duties under this Agreement to any party at any time without

notice to you.

Modifications of Agreement

In-Tools may modify this Agreement at any time without providing notice to you.
Such modification will be made by posting a revised agreement on its web site and
such modification shall be deemed effective immediately upon posting of the modified
Agreement. Your continued access or use of the Software or Services shall be deemed
your acceptance of the modified Agreement. You agree to check our web site periodi-

cally to review such modifications.

Termination or Modifications of Software

You may terminate this Agreement at any time. The In-Tools may immediately termi-
nate the Agreement if you breach any representation, warranty, agreement or obliga-
tion contained or referred to in the Agreement. Upon termination, you must dispose of
the Software and all copies or versions of the Software by destroying the Software. In-
Tools reserves the right to modify the Software at any time without providing notice to
you. In-Tools right to modify the Software applies to all or any aspect of the Software.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT AND
UNDERSTAND IT AND THAT, BY USING THE SOFTWARE, WEB SITE, YOU
AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS.
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